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GENERAL INFORMATION 

 

SCIA Engineer Support 
Via the SCIA Support website:  https://www.scia.net/en/support-downloads 
 

SCIA Engineer – General Environment 

Setup > Options  
Help > Contents > Reference guide 

File > New  > Project data 
 
 

 

Overview of the Menus 

Main Menu & Properties Menu + Actions 
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Overview of the Toolbars 
 

           
 

 
 

 
 

           
 

           
 

Command line 
 

 
 
 
REMARK: If a menu or toolbar has been (accidentally) removed from the project, it can be re-activated via View > Toolbars. 
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INTRODUCTION – OPEN BIM FOR THE STRUCTURAL ENGINEER  

 
 

This exercise is designed to walk a student or new user of the BIM process through a small example project highlighting 
the benefits and pitfalls of model based collaboration using open file formats. The project is a 4 story reinforced concrete building 
with a non-structural curtain wall cladding system. The students play the part of a structural engineering consultant who has just 
received an LOD200 BIM model from the project architect in the schematic design stage. We begin the exercise by verifying the 
model in a third party IFC viewing application. Once verification is complete, we import the model into our structural analysis 
application where we leverage the efforts of the architect into a simplified finite element model, apply loading conditions and run a 
simple linear analysis. We will then make a few small changes to the model, export back out as IFC and once again verify in an IFC 
viewer prior to sending it back to the architect or downstream to detailers or fabrication consultants. We conclude the exercise by 
extracting a calculation report and some simple drawings from our model.    

This tutorial is designed to take between 4 and 6 hours to complete. A folder with all the necessary files has been provided 
with this document. In this folder is a subfolder titled “Step By Step Files”. Each of these files has all the previous steps completed. If 
you get stuck and are short on time, skip ahead to the next section using one of these files. 

 
 

 
Rendering of Architectural Model 
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First Floor Plan of Building 
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PART 1 – VERIFY BIM MODEL AND IMPORT INTO SCIA ENGINEER  

 

3rd Party neutral IFC viewer:  
 

 Tekla BIMsight is a free IFC viewing and mark-up program that can be freely downloaded from the Tekla website. 

- http://www.teklabimsight.com/downloads.jsp 
 

 
 

 Because IFC is an open, vendor neutral file format it is always a good idea to validate any models received from another party 
prior to incorporating them into your engineering process. In this exercise we will use Tekla BIMsight for this purpose.   

- Download, install and open BIMsight. 

- Click the “New Project” button.  

- A new project panel will appear. Click the “View” button to open the new project you have created.  

 

- Navigate to the file “Architectural Model.ifc” provided in the project folder. 

- After a few moments the model should appear. 

- Orbit the model by holding the left mouse button and dragging in the model window. 

- Make the cladding objects invisible by clicking the eye buttons on the right side of the window. 

- Verify that the model has transfered correctly. 
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- You may now close BIM sight. The project file will be saved automatically.  
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Import into SCIA Engineer: 
 

1 Download and Install 
 

 The free student version of SCIA Engineer is available at www.scia-campus.com. 
 

 A new installation of SCIA Engineer may have a simplified UI by default. To complete this exercise, we need access to the 
complete set of commands. Open the “Setup – Options” menu. 

 
 

 In the “Options” dialogue, verify that “Current style of toolbars” is set to “Full toolbars” 

 

2 Import IFC 
When importing an IFC file, SCIA Engineer creates a new file as opposed to placing the IFC into an existing file or template. For this 
example, the instructor has already done some preparation in a template file to speed up the exercise, so it will be necessary to 
import the IFC model and then transfer it into the template. 

 Open SCIA Engineer. If prompted to select a file to open, click cancel so SCIA Engineer starts with no file currently 
open. Your screen should look like this. Note: SCIA Engineer offers different UI “skins” so the coloring may be 
different (light blue).  
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 In the “File” menu select “Import” – “IFC 2x3”. Navigate to the IFC file “Architectural Model.ifc” provided in the project 
folder.  

 You will be prompted with some options regarding the method of import. Select “import as general solids” as shown 
below and leave the rest as default. SCIA Engineer allows you to import an IFC file as either native analytical 
members (beams, columns, plates, etc…) or as “General Solids”. General solids are neutral geometry that have no 
effect on analysis, but can be used as a “Reference Model”. Because this model came from an architect, chances are 
it contains a lot of geometry which is unnecessary or unwanted in our analysis. Things like door knobs and light 
fixtures. Importing as general solids allows us to ignore this additional geometry and offers us more control. 

 

 When this process has completed successfully, you should see the following dialog. Click “OK” to complete the 
import. 

 

 The view can be set to render filled and volumetric with the following 2 buttons. This tool bar is for quick adjustment of 
view and visibility settings. 

 
 

 
 

 
 

 Zoom with the mouse wheel or the 3 navigation bars on the lower right corner of the window.  
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 Orbit by holding down the “Ctrl” button and the right mouse button while moving the mouse. Or, by using the 3 
navigation bars. 

 The strength of an open file format like IFC is the ability to exchange BIM models between software packages 
regardless of what their native file format is. This offers freedom in the choice of software instead of being locked in to 
using software from a specific vendor. The drawback is that each software vendor reads and writes the IFC format a 
little differently and inevitably discrepancies arise. This situation is getting better as more users demand consistent 
IFC model exchange from the software companies.  

 You will notice an example of this in the imported model. The window mullions were not imported into SCIA Engineer. 
This discrepancy is of no significance for our structural model or analysis but, shows the value in validating the model 
in a neutral viewing application prior to import. 

 

 

3 Transfer Model to Provided Template File 
 In the “File” menu select “Save As”. Navigate to the project folder and name the file “Base Model” as shown below. 
 

 
 

 Close the file. 

 Open the file “GT SCIA Template.esa” using the “File” menu or the  button on the tool bar. 

 Double click the “Structure” service in the “Service Tree” as shown below. The Service Tree is the large UI panel on the left side 
of the SCIA Engineer window in this tutorial. The majority of the tools in SCIA Engineer are presented in the various “Services” 
available in this “Tree”. 
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 Double click “Import Project (esa file)” and navigate to the “Base Model.esa” file in the project folder we saved in an earlier step. 
Click open and accept the default “Construction with all other data” in the window presented. 

 
  

 
 
 

 You will notice your cursor dragging the imported model in the 3D workspace. Click at the origin to place the model. Click “Esc” 
to end the command. 

 
 Zoom out so you can see the entire model. Left click, hold and drag a window to select the entire model. With the model 

selected click the pencil button in the “Properties” palette which is on the right side of the SCIA Engineer window throughout this 
tutorial. This will refresh the properties display due to the large number of objects selected. Like most CAD or modelling 
programs, SCIA Engineer has the concept of layers as a way of separating and organizing complex files. Change the layer for 
the selected objects to “Ref Model” in the properties palette. As our structural model develops, this will allow us to always refer 
back to the original geometry and turn it off when convenient.   
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 Now let’s make our reference model transparent so that we can begin to create a structural system within it. Right click with the 
mouse anywhere in the empty space of the 3D window, and select “Set view parameters for all”. In the “Modelling/Drawing” tab, set 
the rendering to “transparent" 

 

 Save your file and continue on to part 2. 
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PART 2 – EXTRACT STRUCTURAL SYSTEM FROM MODEL 

1 BIM Toolbox 
 One of the strengths of SCIA Engineer is its ability to leverage model data from many sources by letting you convert general 

solids into native objects with analytical properties.  

 Open either the file you saved at the end of Part 1 or the file provided in the “Step by Step Files” folder.  

 Navigate to the “BIM Toolbox” by double clicking in the Service Tree. If you are already in another “Service” as a result of the 
last chapter, click “Close” at the bottom of the Service Tree Palette. 

 
 

 
 

 Select a beam element with the mouse in the 3D model. 

 
 

 Highlight the “Role” property field in the properties palette and then click the Funnel/Lightning Bolt button at the top of the 
palette as shown below. This is a quick way to select all elements with a matching property in SCIA Engineer. In this case all 
general solids with the role of “beam”. This “role” property is an additional data field in the IFC file.  
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 You should now have 64 general solids selected. Convert them into native SCIA Engineer analytical 1D members by double 
clicking the “General solid into beam/column” tool in the Service Tree. SCIA Engineer provides options for extraction of multiple 
cross sections along the length of tapered or non-prismatic members, but for this simple example the defaults are adequate. 

 

                
 

 You should notice that the beams are no longer transparent and are now a “pink” color. With the beams still selected, change 
the layer to “Structure” in the properties pallette. This will help us to keep our project organized. 

 
 

 Select one of the beams and in the properties palette click the small elipsis button to the right of the “Cross Section” property. 
This will take you to the cross section database where we can verify the section properties. 
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 Select “CS1 – Rectangle” in the database list and click “Edit”.  

 

 

 Notice the cross sectional properties (Area, Moment of Inertia, etc. …) 

 Click “Cancel” then “OK” to exit back to the work space. 

 De-select any members by clicking “Esc” on the keyboard.  

 Select all general solids with the role “column” using the same process as described above for beams.  

       

 Use “General solid into beam/column” to convert 48 members and set the layer to “Structure” as described above. 



SCIA Engineer BIM Exchange  

18 

 Enter the Cross Section database using the method described above or using this button in the tool bar. Set the 
material to C5000 (5000psi concrete).  

 
 
 

 Repeat the process above selecting all general solids with the role “slab”. 

 Holding “Shift”, left mouse click on the ground floor slab to de-select it. This would be a slab on grade in this project and we do 
not want to include it in our analysis. 

 

 Convert the 4 selected solids into slabs using “General solid into plate/wall” accepting all defaults. Your model should now look 
like this. Set the layer of the slabs to “Structure”. 
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 Manually select the 4 solids representing the core walls as shown above and convert into walls using “General solid into 
plate/wall”. Set the layer to “Structure”. 

 We are done with the reference model for now so we will turn off the visibility of the layer it is in. SCIA Engineer has several 
methods of organizing the model for visibility. These are called “Activities” and are manipulated through the “Activities” toolbar 
shown below. Select “Activity by Layers” and turn off the layer “Ref Model”. This will make it easier to work on our analysis 
model and see results. 
 

 
 

 

 Set the 3D window’s view to be from the X direction using the following button on the “View” toolbar. 
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 Click-Drag twice to select all the nodes at the base of the columns as shown below. The top of the properties palette should 
indicate that 12 nodes are selected.    

 
 

 Double click “Structure” in the Service Tree to gain access to the structure tools. With the 12 nodes still selected, click the 
“Fixed Support” Quick input button to add support conditions to the base of the model. 

 
 

 Each Service in SCIA Engineer provides a set of “Quick Input” buttons just above the command line. These allow easy access 
to commonly needed commands. All of these commands and more are also available in the service tree and menus. 

 Double click “line on 2D member edge” in the service tree. Pay close attention to the hierarchy of the tree in the image below. If 
one of these sub-sections is closed, finding a tool can be confusing to a new user.  

 
 

 Accept the defaults in the dialogue by clicking “OK”. 
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 Click-Drag to select the base of all the core walls as shown below. This will apply a fixed support condition at the base of the 
walls. When you are done selecting the base of the walls, click the “Esc” button to end the command. 

 

 Save your file and continue on to Part 3. 
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PART 3 – ALIGN AND CONNECT MODEL 

1 Align 
 A model created by an architect or other consultant most likely was not assembled with structural analysis in mind. In a finite 

element model, objects such as beams, columns and slabs are represented by their centerline or neutral axis and a stiffness 
matrix. Any other, more complex representation is for visualization purposes only. Our conversion from a volumetric 
architectural model to a simplified finite element model requires 1 more step. We need to make slight adjustments to the 
locations of the members and nodes to achieve transfer of forces and compatibility of deformation. This situation is illustrated in 
the image below. 

 
 

 Fortunately, SCIA Engineer’s BIM toolbox has a system to help with this process. 

 Click the  “AXO” button in the “View” toolbar to orient the workspace view. 
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 Open the BIM toolbox in the Service Tree and double click “Align”. 

 
 

 When prompted to “Proceed with all entities” click “Yes”. 

 
 

 The Properties Palette will now change and display preferences for the align command which we are about to perform. Set 
the preferences exactly as shown in the image below. You should see the bold blue preview of the aligned structure also.  
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 Click the “Run Align” button in the “Actions” at bottom right corner of the SCIA Engineer window. The centrelines of the 
objects have now been aligned. Notice the difference in the transparent image below. The 2 beams, column and slab all 
join in the corner at a single node. 
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2 Connect 
 Turn off the volumetric display of the model using the button in the quick view settings tool bar at the bottom left of the work 

space. 

 
 

 Before we proceed with loading and analysis, we need to tell SCIA Engineer to connect our model. With the entire model de-
selected, click the “Connect members/nodes” button in the “Geometry Manipulations” Toolbar.  

 
 
 

 Click “Yes” to proceed with all entities.  

 Make sure the “Connect 1D members as ribs” box is checked and click “OK”. This will connect our floor and roof beams to the 
floor slab. This is how a monolithically poured, concrete slab and beam system would behave (shear transfer). Otherwise our 
slab would behave like a plate sitting on top of but not connect to, our beams which would be incorrect. 

 
 

 Save your model and continue on to Part 4. 
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PART 4 – APPLY LOADING CONDITIONS 

1 Load panels 
 The curtain wall cladding in this project will be designed by an outside consultant, so we will use a simplification of these 

elements in our analysis. SCIA Engineer provides a type of 2D object known as a “Load Panel” for this purpose. Load 
Panels distribute surface loads such as wind to other members, but do not influence the stiffness of the structure.  

 Enter the “Structure” service from the service tree and double click “Load to panel edges and beams”. 

 
 
      

 Verify the defaults are as shown below. 

 
 

 You will now be in a SCIA Engineer “Sketching Mode”. Cover the exterior of the building with panels by clicking on the 4 corners 
of each planar panel as shown below. Pay close attention to “snapping” at each node. End each panel input (4 clicks) by 
clicking the right mouse button. 
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 Use the “Move to working plane” mode on the “Snapping Toolbar” to project down to the ground level from the roof 
nodes where necessary. This is shown in the image below. 

 

 The “Mirror” tool is also useful in streamlining this process. Input half the panels and then click the “Mirror” button on the 
“Geometry manipulations” toolbar. 
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 Click to define the axis of reflection (the midpoint snapping mode will help with this and is enabled by default). A second click 
completes the action.    

 

 Verify that all the walls of your building are clad with load panels. 
 
 

2 Floor loading 
 Enter the “Load” service through the service tree. 

 Load cases and combinations have already been prepared and provided in the template file you started with. Set the active load 
case to “L” (Live) as shown below. 

 
 

 Double click the “Surface load – on 2D member” button in the list of load types and set the options as shown below. 
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 Enable the “Visibility selection mode” in the “Selections” toolbar. This will make selection of 2D elements easier. This mode can 
be turned on and off anytime. 

 
 
 
 

 Pick the 4 slabs to apply the -40psf live loading. Complete the action with the “Esc” button on the keyboard. 

 
 

 Set the active load case to “Dsup”. This load case represents superimposed dead load for additional partitions, mechanical 
components, etc… The self-weight of the structural members is already included in the load case “Dself”. Repeat the process 
above applying a 15psf load to the 5 slabs. 
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3 Wind Loading 
 Set the active load case to “Wx”. Double click “Surface load – on 2D member” again this time applying the settings shown 

below. Instead of specifying a force as we did for the live and dead loads we are going to set the “Type” of load to “Wind”. This 
will pull the surface pressures, which vary over the height of the structure from a pre-defined wind curve. 

  
 

 Apply this loading to all the load panels which are perpendicular to the wind direction (X). It may be easier to complete this 
action with the “Visibility selection mode” disabled, due to the panels being transparent. 

 
 

 Set the active load case to “Wy” and repeat the process for the Y direction.  
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4 Load Combinations 
 Click “Close” at the bottom of the service tree palette to return to the main tree. Now enter the “Combinations” service and 

review the load combinations that have been prepared prior to this exercise.  
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 ULS combinations are strength (factored) load combinations and envelopes. 

 SLS combinations are serviceability (un-factored) load combinations and envelopes. 

 Save your file and proceed to Part 5. 
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PART 5 – ANALYSIS AND RESULTS 

1 Finite Element Mesh 
 

 The finite element mesh in SCIA Engineer is automatically generated prior to running the solver. This is a significant 
advantage over the more manual meshing process encountered in other software. The choice of mesh size and 
refinement can have an impact on the validity of results when using the finite element method, therefore it is always 
important to visually verify the mesh before accepting any results. 

 Enter the “Mesh Settings” from the service tree. 

 
  

 Set the number of 1D mesh elements to 5 and the 2D mesh size to 2ft as shown below. 

 
 

 Click “OK” to apply the settings.  

 Click “Yes” if you receive a warning about changing the settings. 

 Double click “Mesh generation” in the service tree. You should be presented with a dialog displaying the results of the 
meshing process. 
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 Click “OK” to accept. 

 Turn off the visibility of loads in the quick view settings tool bar. 

 
 
 

 Select all the load panels using the “Select Elements by Property” button and a matching property. 

 Set the layer of the load panels to “Clad” 

 

 

 Enable the mesh visibility in the quick visibility settings. 
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 Verify that the generated mesh is acceptable.  
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2 Static Linear Analysis 
 

 Double click “Calculation” in the service tree 

 Select “Linear Calculation” and click “OK” 

 
 

 During the calculation process you should see a solver status window. 

 
 

3 Results 
 

 When the solver is complete you will see that a new service “Results” has appeared in the tree. 



 SCIA Engineer BIM Exchange 

37 

 Enter this “Results” service, select “Reactions” and set the following properties in the properties palette. 

 Click “Refresh” in the “Actions” at the bottom right of the SCIA Engineer window. 

 
 

 

 These are the critical support reactions for the ULS envelope. 

 Turn off the mesh display. 

 
 

 Select “Internal Forces on Beam” in the service tree. Set the properties as shown below.  
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 Click the ellipsis button next to “Drawing setup 1D” in the properties palette. 

 Set the “Representation” to “Filled” 

 
 

 Refresh the results display. You should see the strength level Y axis moment envelopes for the beams and columns. 

 
 Click “Preview” in the “Actions” at the bottom right corner of the SCIA Engineer window. 
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 The “Preview” window allows you to display results and other data in tabular form. In the current table the critical results for 
each 1D member are displayed. Close the preview window by clicking the “X” button at the top right of the table. 

 Select “Displacement of nodes” in the tree and set the following properties in the properties palette. 

    
 

 Refresh the display. This is the vertical deformation under service level loads. This is for elastic behaviour only. In a real 
project we would need to account for cracking, creep and other non-linear and time dependant effects.  
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 Right click in the 3D window and select “Picture to Gallery”. 

 

 Set the “Display Mode” to “Standard” and click “OK”. This will save this view of the model in our “Picture Gallery”. We will 
use this in Part 6. 

 

 As you can see there are many ways to display the analysis results in SCIA Engineer.  

 Save your file and proceed to Part 6. 
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PART 6 – STRUCTURAL MODEL EXPORT 

 
One of the features that differentiate SCIA Engineer from traditional Finite Element Analysis software is that it maintains 2 

versions of the model in parallel. SCIA Engineer has the traditional “Analysis Model” which consists of bars, nodes, shells etc. … 
This model is what you are actually analysing, but is not very useful for communicating design intent or for exchange with another 
consultant. The second model representation is the “Structural Model” which is dimensionally accurate and can be used to extract 
drawings, generate renderings and be exported for collaboration. 

It would be very unlikely that the member sizes defined by the architect would be correct from an engineering point of view. 
In this exercise we have determined that the beam sizes are inadequate and we need to propose a change and communicate this 
back to the architect through a revised model. 

 

 Open the Cross-Sections Database.  
 

 Select “CS1” and click “Edit” 

 Change the “H”(height) parameter to 20in. 

 
 

 Exit the cross section database and set the rendering mode to volumetric and filled. 

 
 

 Select all 1D members with the property “Structural model – Mode” set to “General. If executed correctly you should 
have 112 members selected. 
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 Set “Structural model – Mode” to “Automatic”. These modes determine how much flexibility the user has in manually 
adjusting the “Structural Model” in relation to the “Analytical Model”. In our case we want SCIA Engineer to take care 
of most of this automatically. 

 Select all the beams which have the “Structural model – Eccentricity z” set to -12in. Set this parameter to 0in. 
 

 
 

 Click the “Generate structural model” button to refresh the view. 

 
 
 

 Select all the 1D members with “Type” set to “column”. 

 
 

 Set the “Structural model – Mode” to “Manual” and set the “begin x-offset” and “end x-offset” parameters to 4in. 

 
 

 Set your view to be from the X direction . Drag a selection box across the first floor columns from right to left. 
When you select from right to left all objects crossed by the selection box are selected. When you select from left to 
right only objects completely inside of the selection box are selected. 
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 Set the “begin x-offset” property to 0in.  

 Refresh the structural model. 

 Drag a selection box around the entire model from left to right. When we export our revised model to IFC, we don’t 
need to include the reference model layers. An easy way to filter the geometry to export is through selection. 

 

 Select “File – Export – IFC 2X3” from the menu. 
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 Select a suitable name and location for the exported file. 

 When prompted with options for the geometrical representation, set the parameters as shown below. Different 
software packages expect geometry to be represented using different data structures. “SweptSolid” is a simple 
extrusion with a profile and path. Most software can support this geometry type and will convert it into a native object 
of some type. “Brep” is short for boundary representation. This data structure supports more detail than swept solids, 
but typically does not get converted into a native object type in the target application. There are benefits and 
shortcomings to each method depending on the context. 

 
 

 Open the Tekla BIMsight project you created in Part 1. Click “Add File” and select the file you just exported from SCIA 
Engineer. 

 
 

 Explore the different options for comparing the 2 models. 

 
 

 Save your SCIA Engineer file and proceed to Part 7. 
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PART 7 – DRAWINGS 

 
One of the immediate benefits of constructing a BIM model as opposed to traditional CAD drawings is coordinated 

documentation. In the past when a change was made on a 2D drawing, any other related drawings or layout pages also had to be 
manually reviewed and revised. This is a major source of potential errors.  When documents are derived from a 3D BIM model, much 
of this manual coordination can be automated. SCIA Engineer offers a system for extracting drawing views from your model. These 
drawings are generated based on styles that the user can predefine to company standards and can be placed on layout pages for 
printing.  

 

 Enable the display of “Plane sections” from the quick view settings. 

 
 

 You should see 2 section planes. 1 plan view and 1 section view. These drawing sections were predefined in the 
template file to save time during this exercise. 

 
 

 Enter the drawing manger from the Service Tree. In the “Drawing Manger” mark the checkbox next to PS1 and click 
“OK”. 

                          
 

 You should now be in the SCIA Engineer 2D Drawing environment. The drawing generated is based on a set of 
criteria and associated line types, hatches, labels etc… 
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 Click the ellipsis button next to “Section drawing style”. 

 
 

 In the “Drawing style editor” select the “Conc_P” style and click “Edit”.  
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 This is the drawing “style” definition. The general idea is that members and objects that meet criteria in the list on the 
left are drawn using attributes chosen on the right. Additional “rules” can be added to the list and they are organised 
by priority from top to bottom. Feel free to experiment with the results of adjusting the rules. 

 
 

 Return to the drawing environment and click “Refresh” in the “Actions” to refresh the drawing. 

 
 

 Click “Paperspace gallery” in the tool bars.  

 Add a new page to the gallery. Name it something reasonable. 

 
 

 SCIA Engineer provides some default title blocks and you are also able to construct or add your own by importing .dwg or 
.dxf files. 

 Select “Insert picture from plane section” from the drawing menu. 
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 Choose a drawing from the drawing manager and place it on the layout. 

 There are many other items that can be placed on the layout pages including 3D views from the picture gallery, tables from 
the calculation reports and drawings from other CAD programs.  

 

Conclusion 
In this exercise we explored how members of the design team can share BIM models from various sources and authoring 

tools using open file formats like IFC. We also walked through the steps necessary to utilize this data in performing typical analysis 
and preparation of construction documentation. I hope this exercise has been interesting and informative. Please send any questions 
or comments to the author. 
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ANNEXES 

Annex 1: Connection of entities 
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Annex 2: Conventions for the results on 2D members 

1 Basic magnitudes = Characteristic values 

Bending (plates, shells) 

 Bending moments mx, my 
 

 
 
 

 Torsion moment mxy 
 

 
 
 

 Shear forces qx, qy (=vx, vy) 
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Membrane effects (walls, shells) 
 Membrane forces nx, ny 

 
 
 

 Shear forces qxy (=nxy) 
 

 
 
 
 
 

2 Principal magnitudes 
The principal magnitudes give the results according to the axes of the directions of the largest stresses (principal directions). These 
directions are defined with the help of the circle of Mohr. 
` 

3 Dimensional magnitudes = Design values 
To derive the dimensional magnitudes from the basic magnitudes, formulas from the Eurocode are used. 
 
See also Help > Contents > Reference guide for these formulas. 
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Annex 3: Results in Mesh elements and Mesh nodes > 4 Locations 
 

During a calculation in SCIA Engineer, the node deformations and the reactions are calculated exactly (by means of the 
displacement method). The stresses and internal forces are derived from these magnitudes by means of the assumed basic 
functions, and are therefore in the Finite Elements Method always less accurate.  
 
The Finite Elements Mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements. Per mesh element 3 or 4 results are 
calculated, one in each node. When asking the results on 2D members, the option ‘Location’ in the Properties window gives the 
possibility to display these results in 4 ways. 

 

1 In nodes, no average 
All of the values of the results are taken into account, there is no averaging. In each node are therefore the 4 values of the adjacent 
mesh elements shown. If these 4 results differ a lot from each other, it is an indication that the chosen mesh size is too large. 
 
This display of results therefore gives a good idea of the discretisation error in the calculation model.  

 

   
 

2 In centres 
Per finite element, the mean value of the results in the nodes of that element is calculated. Since there is only 1 result per element, 
the display of isobands becomes a mosaic. The course over a section is a curve with a constant step per mesh element.  

 

   
 

3 In nodes, average 
The values of the results of adjacent finite elements are averaged in the common node. Because of this, the graphical display is a 
smooth course of isobands. 

 
In certain cases, it is not permissible to average the values of the results in the common node: 

- At the transition between 2D members (plates, walls, shells) with different local axes. 
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- If a result is really discontinuous, like the shear force at the place of a line support in a plate. The peaks will disappear 
completely by the averaging of positive and negative shear forces. 

 

   
 

4 In nodes, average on macro 
The values of the results are averaged per node only over mesh elements which belong to the same 2D member and which have the 
same directions of their local axes. This resolves the problems mentioned at the option ‘In nodes, average’.  

 

   
 
 

Accuracy of the results 
If the results according to the 4 locations differ a lot, then the results are inaccurate and the mesh has to be refined. A basic rule for a 
good size of the mesh elements, is to take 1 to 2 times the thickness of the plate. 
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Annex 5: Overview of the Icons in Windows & Toolbars 

1 Main Window 
In the Main window one can find the links to the most used menus and actions. Some of those links are only activated when 
they can be effectively used in the project: e.g. the link to the Results menu is only shown after a calculation has been 
performed, and the Steel and/or Concrete menus are visible depending on the materials applied in the project. 
 

 

2 Properties Window 
The Properties window gives information about selected objects and/or actions. Moreover it is possible to adjust the 
properties of each object directly via this menu. When several kinds of objects or actions are selected at the same time, it is 
possible to switch between their properties by means of the little arrow behind the object name. The number between 
brackets behind the object name represents the number of objects of this kind that is selected at this moment. If the number is 
larger than 1, only the corresponding properties are shown. 
 

 
 

 Select elements by more properties 

 Select elements by property 
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3 Menu Bar 

 
These ‘written’ menus group all actions by subject. A large number of these actions is also available in the Main menu and/or 
as icon in the toolbars. 
 

4 Standard Toolbars 

 
The ‘Activity’ toolbar provides options for the visibility / invisibility of specific parts of the structure, which increase the ease of 
working and the readability of the project. 
 

 Activity toggle 

 Activity by layers 

 Activity by selection (Selected members On) 

 Activity by selection (Selected members Off) 

 Activity by working plane 

 Activity by clipping box 

 Invert current activity 

 Draw inactive members 
 

 
The ‘Basic’ toolbar contains a number of primary actions with regard to the current project and allows to modify the basic 
settings of the program (Setup Options). 
 

 New (Ctrl+N) 

 Open (Ctrl+O) 

 Save (Ctrl+S) 

 Undo 

 Redo 

 Setup 

 About SCIA Engineer 

 Name of the opened *.esa file 
 

 
The ‘View’ toolbar allows for the execution of a whole lot of simple view manipulations. 
 

 View in direction X 

 View in direction Y 

 View in direction Z 

 View in direction AXO 
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 View perpendicular to working plane 

 Zoom in 

 Zoom out 

 Zoom by cut out 

 Zoom all 

 Zoom selection 

 Perspective view 

 Undo view change 

 Redo view change 

 Generate structural model 

 Regenerate view 
 

 
In the ‘Geometry manipulations’ toolbar one can find manipulations with basic entities (nodes, 1D members, 2D members), as 
well as with additional data. 
 

 Move 

 Copy 

 Multicopy 

 Rotate 

 Scale 

 Stretch 

 Mirror 

 Trim 

 Extend 

 Enlarge by defined length 

 Break in defined points 

 Join 

 Break in intersections 

 Reverse orientation 

 Polyline edit 

 Curves edit 

 Calculate member end-cuts 

 Connect members/nodes 

 Disconnect linked nodes 

 Copy additional data 

 Move additional data 
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The ‘Modelling tools’ toolbar provides for manipulations with general solids. 
 

 Union of solids 

 Subtraction of solids 

 Intersection of solids 

 Division of solids 

 Generate vertexes 

 Clash check of solids 

 Move vertexes/points 
 

 
The ‘Project’ toolbar collects various actions, from the definition of databases (layers, materials, cross-sections) for the 
project, to several options for the output. 
 

 Units 

 Layers 

 Materials 

 Cross-sections 

 Check structure data 

 Mesh generation 

 Calculation 

 Hidden calculation 

 Print data 

 Print picture 

 Picture gallery 

 Paperspace gallery 
 

 
The ‘Selection of object’ toolbar contains different possibilities to select a specific part of the structure. A selection can also be 
saved and loaded again later on. 
 

 Selection by mouse 

 Selection by cut out 

 Selection by intersecting line 

 Selection by polygonal cut out 

 Select all 

 Selection by working plane 
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 Previous selection 

 Cancel selection 

 Selection mode toggle (Select or Deselect) 

 Single selection mode toggle (All found or First found) 

 Save selection 

 Load selection 

 Filter for selection on/off 

 Filter by service tree on/off 
 

 
In the ‘Tools’ toolbar a number of clever means can be found for the input and graphical display of a structure. 
 

 Setup UCS 

 Clipping box 

 Dot grid setting 

 Line grid 

 Scale factor 

 Scale manager 

 Coordinates info 
 

5 Command line Toolbars 
On the Command line itself, a number of commands for the operation of the program can be inputted. Also, during running 
actions, instructions on the next steps are shown. 
Apart from that, quite a number of toolbars can be found here; some of them are only available during a certain action or in a 
specific menu. 
 

 
 

 Show/Hide surfaces 

 Render geometry 

 Show/Hide supports 

 Show/Hide loads 

 Show/Hide other model data 

 Show/Hide labels of nodes 

 Show/Hide labels of members 

 Show/Hide dot grid 

 Set load case for display 

 Fast adjustment of view parameters on whole model 
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 Fast adjustment of view parameters on selection 
 

 Cursor snap settings 

 Fast adjustment of cursor snap settings 
 

 Change insertion point, available during input of geometry 
 

 Definition of new form, available during input of geometry 
 

 Fast input of supports & hinges, available in Structure menu 
 

 Fast input of loads, available in Load menu 
 

 Fast display of results, available in Results menu 
 

 Adjust Units of length 

 Change Active working plane 

 Adjust Cursor snap settings 

 Adjust UCS (=User Co-ordinates System) 

 Change Active code 
 


